Artisan® 710 Series

Quick Guide
Basic Copying, Printing, and Scanning
Maintenance
Solving Problems
Using the Control Panel ............................................ 4
Adjusting the Control Panel ........................................ 5
Charging USB Devices ................................................ 6

Loading Paper .......................................................... 7
Using Special Papers ................................................... 10

Placing Originals for Copying or Scanning .................... 12

Copying a Document or Photo ...................................... 13
Copying a Document ................................................... 13
Restoring, Cropping, or Copying Photos ......................... 14

Printing From Your Camera’s Memory Card .................... 17
Inserting Your Camera’s Memory Card ........................... 17
Inserting a USB Flash Drive .......................................... 19
Selecting and Printing Photos ....................................... 20

Printing Special Projects ............................................. 22
Printing Coloring Book Pages ........................................ 22
Printing Lined Paper and Graph Paper ............................ 23
Printing Personal Note Paper ........................................ 24

Printing From Your Computer ...................................... 26
Printing in Windows .................................................... 26
Printing With a Macintosh .............................................. 28
Selecting the Correct Paper Type ................................... 32
Two-sided Printing ...................................................... 33

Scanning a Document or Photo .................................... 35
Basic Scanning ........................................................... 35
Maintaining Your All-in-One ........................................ 37
Checking the Print Head Nozzles .............................. 37
Cleaning the Print Head ............................................ 38
Checking the Ink Cartridge Status ............................ 39
Purchasing Epson Ink Cartridges .............................. 40
Replacing Ink Cartridges ......................................... 41

Solving Problems .................................................... 43
Checking for Software Updates ............................... 43
Problems and Solutions .......................................... 44
Where To Get Help ................................................ 46

Notices ..................................................................... 47
Using the Control Panel

- To save energy, the LCD goes dark after 13 minutes of inactivity. Press any button (except the On button) to wake it up.

- To switch the screen from displaying one photo at a time to 9 photos at a time, press the Display/Crop button 3 times when viewing your photos.

- The blue status light at the bottom of the panel flashes when the Artisan 710 Series is operating or performing routine maintenance.

Note:
If the blue status light flashes rapidly, check the control panel for error messages.
You may see the following icons on the screen:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The Artisan 710 Series is connected to a wired network</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The Artisan 710 Series is connected to a wireless network</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The current photo is cropped</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The Fix Red-Eye setting is on for the current photo or all photos</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Reminds you whether View Auto Correct is on or off (see page 20)</td>
</tr>
</tbody>
</table>

**Adjusting the Control Panel**

The control panel is adjustable. To raise it, lift it as shown below. To lower it, press the Unlock button and then push the control panel down.

**Caution:**

To avoid damaging the Artisan 710 Series, always press the Unlock button to lower the control panel. Don’t try to push it down.
Charging USB Devices

You can charge your cell phone, MP3 player, or other portable device by connecting it to the Artisan 710 Series. All you need is a user-supplied USB cable that's designed to work with your device (one may have come with it).

Caution:
Make sure your portable device complies with USB 2.0 standards. Devices that draw more than 500 mA may damage your Epson product. Epson cannot guarantee the compatibility of your device. Contact the manufacturer of your device for more information.

1. Turn on your Artisan 710 Series.
2. Connect your portable device to the ⚫ USB port on the front of your Artisan 710 Series.
3. Leave your Artisan 710 Series on while charging (it will continue to charge even after going into sleep mode).

Note:
You cannot use the ⚫ USB port to transfer images from your portable device to your computer. If you want to transfer images, use the memory card slots instead (see the online Epson Information Center for instructions).
Loading Paper

Your Artisan 710 Series has two paper trays. The main tray is for letter-size, legal-size, A4, or 8 × 10-inch paper. You can load up to 120 sheets of letter-size or A4 plain paper in the main tray. When extended, the tray can hold up to 50 legal-size sheets.

The photo tray is for 4 × 6 or 5 × 7-inch photo paper. You can load up to 20 sheets. Check your online Epson Information Center for detailed information about sheet capacity for each paper size and type.

1. Pull out the paper cassette. Then slide back the photo tray and lift it up.

2. Squeeze the edge guides and slide them out. Then insert paper with the glossy or printable side face-down.

   For legal-size paper, squeeze lever to extend tray.

   **Note:**

   Load letterhead or pre-printed paper face-down, with the top edge at the back of the paper cassette. To load legal-size paper, squeeze the lever and extend the tray.
3. Slide the left edge guide against the paper.

4. Adjust the front edge guide to your paper size.

5. Lower the photo tray.

8 Loading Paper
6. To load paper in the photo tray, squeeze the edge guides and slide them out. Then insert photo paper with the glossy or printable side face-down.

![Image of photo tray with paper inserted]

7. Slide the left edge guide against the paper. Then adjust the front edge guide to your paper size.

![Image of adjusting edge guides]

**Note:**
Make sure the paper fits under the edge guide.

8. Keep the cassette flat as you insert it.

![Image of cassette being inserted correctly]
9. Extend the output tray and flip up the stopper.

For details on paper and instructions on loading envelopes and legal-size sheets, see the online *Epson Information Center*.

**Using Special Papers**

Epson offers a wide array of high quality papers, making it easy to maximize the impact of your photos, presentations, and creative projects.

You can purchase genuine Epson ink and paper at Epson Supplies Central℠ at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S042181, S042174</td>
<td>60, 100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 inches</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S042182, S042175</td>
<td>25, 50</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041405</td>
<td>50</td>
</tr>
<tr>
<td>Paper name</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------</td>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041808</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041727</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 inches</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S042183</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041667</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Borderless 4 × 6 inches</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041809</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042038</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041141</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041649</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
<td>100</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041341</td>
<td>50</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Borderless 8 × 10 inches</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041280</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches)</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 × 11.7 inches)</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041153</td>
<td>10</td>
</tr>
</tbody>
</table>
Placing Originals for Copying or Scanning

You can place one or two photos or a document up to letter-size (or A4) on the scanner glass to make color or black and white copies.

1. Open the document cover and place your original face-down on the scanner glass, with the top against the back left corner.

   If you’re scanning 3 × 5- or 4 × 6-inch photos, you can place up to two at a time on the scanner glass. Place them at least 1/4 inch (5 mm) apart.

   ![Diagram showing placement of photos on scanner glass]

   **Note:**
   If the edges of your document or photo are cut off, move the document or photo 1/4 inch (5 mm) away from the corner of the scanner glass.

2. Close the cover gently so you don’t move the original(s).
Copying a Document or Photo

Once you’ve placed your originals on the scanner glass (see page 12), you can make color or black and white copies.

Copying a Document

2. Press the Home button until Copy is selected.
3. Press OK.
4. Press + or – to select the number of copies you want.
5. Press ▲ or ▼ to select Color or B&W (black and white) copies.
6. Press ◄ or ► to adjust the density (make the copies lighter or darker) if necessary.
7. To change copy settings, press ☐ Menu, then OK to select Paper and Copy Settings. The Layout setting should be With Border and the Paper Size should be Letter.
   - To print on both sides of the page, press ▼ to select 2-Sided Printing, press ►, then press ▲ or ▼ to choose Off or On.
   - To adjust the copy size, press ▼ to select Reduce/Enlarge, press ►, then press ▲ or ▼ to choose Actual (and select a percentage using + or –), Auto Fit Page (to automatically size the image to fit your paper), or one of the specific sizes listed. Then press OK.
   - Press ▼ to scroll down to the Paper Type setting and select Plain Paper. Then press OK.
   - For the Document Type setting, choose Text for plain documents or Text & Image if your document contains photos or graphics. Then press OK.
To change the copy quality, select **Quality**, press ▶️, then press ▲ or ▼ to choose **Draft**, **Standard Quality**, or **Best**. Then press OK.

For more information about copy settings, see your online *Epson Information Center*.

8. After you finish selecting your settings, press OK.

9. Press ◈ **Start** to begin copying. To cancel copying, press ◈ **Stop/Clear Settings**.

---

## Restoring, Cropping, or Copying Photos

You can copy one or two photos onto 4 × 6-inch, 5 × 7-inch, 8 × 10-inch, or letter-size photo paper for instant photo reprints. You can also restore colors in faded photos, print with or without borders, convert photos to black and white, and crop your photos.

1. Place one or two photos on the scanner glass. Place them at least 1/4 inch (5 mm) apart.

2. Load 4 × 6-inch or 5 × 7-inch paper in the photo tray or 8 × 10-inch or letter-size Epson photo paper in the main tray. Load it printable side down.

3. Press the **Home** button until **Copy** is selected, then press OK. You see this screen.

4. Press ◆ **Menu**, press ◀ or ▶ to select **Copy/Restore Photos**, then press OK.

5. To turn on Color Restoration to restore colors in faded photos as you copy, press ▼ to select **On**. (If your photos are not faded, select **Off**.) Then press OK.
6. When you see this screen, press OK to prescan your photos.

7. When you see a message asking you to select the number of copies, press OK.

8. If you placed two photos on the scanner glass, press ◀ or ▶ to view the second one and select the number of copies.

9. To print more than 1 copy, press + or – to select the number (up to 99). If you are copying 2 photos, do this for the other photo as well.

10. To crop the photo and enlarge the resulting image area to fit onto your paper, press Display/Crop.
    - To resize the image area, press + or –.
    - To move the image area, use the arrow buttons.
    - To check the zoomed image, press OK.

    When you finish cropping your photo, press OK.

11. Press OK again to continue.

12. To change any of the settings displayed on the screen, press Menu and then OK to select Paper and Copy Settings.

    Note:
    To clear previously used copy settings, press Stop/Clear Settings.
    - To change the paper size, select Paper Size and choose the size of paper you loaded. Press OK. (Paper Size options depend on the Paper Type setting you choose.)
To change the paper type, select **Paper Type**, press ▶️, then press ▲ or ▼ to choose the setting for the paper you loaded:

<table>
<thead>
<tr>
<th>For this paper type</th>
<th>Choose this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Matte</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td></td>
</tr>
</tbody>
</table>

To change the print layout, select **Borderless**, then press ▶️. Press ▲ or ▼ to choose **On** to expand the image all the way to the edge of the paper (slight cropping may occur) or **Off** to leave a small margin around the image. Then press **OK**.

To adjust the amount of image expansion when printing borderless photos, select **Expansion**, press ▶️, then press ▲ or ▼ to choose **Standard**, **Medium**, or **Minimum**. Then press **OK**. (Your printed photos may have white borders if you use the **Medium** or **Minimum** setting.)

To automatically adjust brightness, contrast, and saturation to best effect, select **Fix Photo**, then press ▶️. Press ▲ or ▼ to choose **On**.

If you want to create a black-and-white copy of a color photo, select **Filter**, press ▶️, then press ▲ or ▼ and choose **B&W**. Then press **OK**.

13. After you finish selecting your settings, press **OK**.

14. When you're ready to copy, press ◇ **Start**. To cancel copying, press ◇ **Stop/Clear Settings**.

**Note:**
When you scan with your computer, you can use additional options to transform faded, dusty, or badly exposed photos into ones with true-to-life color and sharpness. See the online Epson Information Center for details.
Printing From Your Camera’s Memory Card

The Artisan 710 Series lets you print photos from your digital camera’s memory card, or from an external storage device such as a USB flash drive.

Note:
You can print directly from your camera if it supports PictBridge™ printing. See the online Epson Information Center for instructions.

Inserting Your Camera’s Memory Card

1. Insert the card into the correct slot, as shown. Insert just one card at a time.

**Upper slot:**
- SD™, SDHC™
- miniSD™*, miniSDHC™
- microSD*, microSDHC*
- MultiMediaCard™
- MMCplus, MMCmobile, MMCmicro*
- Memory Stick™
- Memory Stick Duo™*
- Memory Stick Micro™*
- Memory Stick PRO™
- Memory Stick PRO Duo™*
- Memory Stick PRO-HG Duo*
- MagicGate™ Memory Stick
- MagicGate Memory Stick Duo™*
- xD-Picture Card™
- xD-Picture Card Types H, M, M+

**Lower slot:**
- CompactFlash®
- Microdrive™

* Adapter required
Make sure the image files on your card meet these requirements:

<table>
<thead>
<tr>
<th>File format</th>
<th>JPEG with the Exif version 2.21 standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image size</td>
<td>80 × 80 pixels to 9200 × 9200 pixels</td>
</tr>
<tr>
<td>Number of files</td>
<td>Up to 9990 (If there are more than 999 photos on the card, you can select a group of photos to display.)</td>
</tr>
</tbody>
</table>

2. After you insert the card, the memory card access light flashes, then stays on.

   Caution:
   Do not remove the card or turn off the Artisan 710 Series while the light is flashing, or you may lose data on the card.

3. See page 20 to select and print your photos.

**Removing Your Card**

After you finish printing your photos, follow these steps to remove the card:

1. Make sure the memory card access light is not flashing.

2. If the Artisan 710 Series is connected to your computer with a USB cable, do one of the following before removing the memory card or turning off the printer:
   - **Windows®**: Click the or icon on the taskbar and select Safely remove USB Mass Storage Device.
   - **Macintosh®**: Drag the removable disk icon from your desktop into the trash.

   Note:
   If your printer is connected to your Macintosh over a network, do not drag the icon to the trash.

3. Pull the card straight out of its slot.
Inserting a USB Flash Drive

You can print from an external storage device connected to the Artisan 710 Series, such as a USB flash drive, external hard drive, or CD burner.

**Note:**
Epson cannot guarantee the compatibility of any drives. You may not be able to print photos from the storage device if they were saved to the device using a product other than the Artisan 710 Series.

1. Remove any inserted memory card from the Artisan 710 Series.
2. Insert your USB flash drive or the USB cable for your external drive into the USB port on the front of your Artisan 710 Series.
3. Insert storage media (such as a CD) into your drive, if necessary.
4. If there are folders on your storage media, select the folder you want and press **OK**.
5. See the next section to select and print your photos.

**Note:**
Before removing your USB drive, make sure its access light is not flashing.

You cannot use the USB port to transfer images from your external storage device to your computer. If you want to transfer images, use the memory card slots instead (see the online *Epson Information Center* for instructions).
Selecting and Printing Photos

1. Load Epson photo paper. See page 10 for a list.

2. Press the Home button until Print Photos is selected, then press OK.

3. Select View and Print Photos and press OK.

4. Press ◁ or ▶ to move through your photos and display one you want to print.

   Tip:
   If View Auto Correct: Off appears at the top of the display screen, press the View Auto Correct button to preview how your printouts will look with Fix Photo turned on (see page 21).

5. To print more than one copy, press + or – to select the number of copies you want of that photo.

6. To crop the photo, press the Display/Crop button.
   ■ To resize the image area, press + or –.
   ■ To move the image area, use the arrow buttons.
   ■ To rotate the image area, press ≡ Menu.
   ■ To check the zoomed image, press OK.

   When you finish cropping your photo, press OK.

7. Press ◁ or ▶ to view other photos, select the number of copies, and crop, if desired.

8. When you’re done selecting photos, press OK. You see the Print Preview screen:

9. To change any of the print settings displayed on the screen, press ≡ Menu, select Print Settings, press OK, and select your settings.
For a list of Epson papers and the corresponding Paper Type settings, see page 16. When you’re done selecting settings, press OK.

10. To change any of the photo adjustments displayed on the screen or fix red-eye, press \( \equiv \) Menu. Select Photo Adjustments, press OK, and select your settings.

**Note:**
For the best quality printing, leave Fix Photo (in the Photo Adjustments menu) turned on. This automatically adjusts brightness, contrast, and saturation to best effect.

Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject’s face (without sunglasses). If your photo includes a face with an intentional color cast, such as a bronze statue, you may want to turn off this setting to retain the special color effects.

11. When you’re ready to print, press \( \triangleright \) Start. To cancel printing, press \( \triangleright \) Cancel.

**Note:**
To switch the display screen from displaying one photo at a time to 9 photos at a time, press the Display/Crop button 3 times when viewing your photos.

See the online Epson Information Center to learn about other ways you can lay out photos when printing from a memory card.
Printing Special Projects

You can use your Artisan 710 Series to make coloring book pages for your kids, ruled paper and graph paper for homework projects, and even note paper personalized with your favorite photos.

Printing Coloring Book Pages

Your Artisan 710 Series can turn any photo or drawing into a coloring book page.


2. Press the Home button, if necessary.

3. Press < or > and select Coloring Book.

4. Do one of the following:
   - Select Photo or Drawing on the Scanner and place your photo or drawing face-down on the scanner glass, in the back left corner. Press OK.
   - Select Photo on Memory Card, make sure your memory card is inserted, and press OK. Press < or > to select the photo you want to use, then press OK.

5. Select the paper size and type, then press OK.
6. If necessary, press \( \equiv \) Menu and select Print Settings to adjust the Density (how dark your coloring book page will print) or Line Detection (to change the amount of detail in the picture). Press OK.

7. When you’re ready to print, press \( \odot \) Start. To cancel printing, press \( \odot \) Stop/Clear Settings.

---

**Printing Lined Paper and Graph Paper**

You can have the Artisan 710 Series print lined paper or graph paper whenever you need it.

1. Load letter- or A4-size plain paper.
2. Press the Home button.
3. Press \( \leftarrow \) or \( \rightarrow \) to select Print Ruled Papers, then press OK. You see this screen:

![Print Ruled Papers Screen]

4. Press \( \leftarrow \) or \( \rightarrow \) and select Wide Rule, Narrow Rule, or Graph Paper for your paper size. Then press OK.

5. When you see a message asking you to load paper, press OK.
6. To print more than 1 sheet, press \( + \) or \( - \) to select the number (up to 99).
7. When you’re ready to print, press \( \odot \) Start. To cancel printing, press \( \odot \) Stop/Clear Settings.
Printing Personal Note Paper

You can print lined or unlined notepaper, personalized with a photo in the background.

1. Load letter- or A4-size plain paper.
2. Insert a memory card (see page 17) or USB drive (see page 19).
3. Press the Home button.
4. Press ◄ or ► to select Print Ruled Papers, then press OK.
5. Press ◄ or ► and select one of the Stationery settings (with or without lines) for your paper size. Then press OK.

6. When you see this screen, press OK.
You see a preview of how your stationery will look with a photo in the background.

7. To rotate the layout, press ▼.

8. Press ◀ or ▶ to move through your photos and display the one you want to use for your notepaper.

9. Press OK.

10. When you see a message asking you to load paper, press OK.

11. To print more than 1 sheet, press + or − to select the number (up to 99).

12. When you’re ready to print, press ◇ Start. To cancel printing, press ◇ Stop/Clear Settings.
Printing From Your Computer

This section describes the basic steps for printing a photo or document stored on your Windows® or Macintosh® computer. For instructions on two-sided printing, see page 33. For additional printing instructions and to learn about CD printing, see the online Epson Information Center.

Before you start, make sure you’ve installed your printer software and connected the Artisan 710 Series to your computer or network as described on the Start Here sheet or Network Installation Guide.

Tip:
It’s a good idea to check for updates to your Artisan 710 Series software. See page 43 for instructions.

You can also create personalized photo greeting cards, calendars, and more using the ArcSoft Print Creations™ software included with your Artisan 710 Series. To get started, double-click the Print Creations icon on your desktop (Windows) or in your Applications folder (Macintosh).

Printing in Windows

1. Open a photo or document in an application.
2. Open the File menu and select Print. You see a window like this one:
3. Select your Epson Artisan 710 Series, then click the **Preferences** or **Properties** button.

**Note:**
If you see a **Setup**, **Printer**, or **Options** button, click it. Then click **Preferences** or **Properties** on the next screen.

4. On the Main tab, select the basic print settings. Make sure you choose the correct paper **Type** setting for the paper you are using (see page 32).

![Printing Preferences window](image)

**Note:**
For quick access to the most common settings, click the **Shortcuts** tab and select one of the presets. You can create your own presets by clicking the **Save Settings** button on the **Advanced** tab. For details, see your online Epson Information Center.

5. To improve the color, contrast, and sharpness of photos, select **Fix Photo**.

6. To reduce or remove red-eye effects in photos, select **Fix Red-Eye**.

7. If you want to reduce or enlarge your printout, or print double-sided, click the **Page Layout** tab and select settings as necessary.

8. For more printing options, click the **Advanced** tab.

**Note:**
For more information about print settings, click **Help** or see your online Epson Information Center.

9. Click **OK** to save your settings.
10. Click OK or Print to start printing. This window appears and shows the progress of your print job.

Printing With a Macintosh

See the section below for your Mac OS® operating system.

Mac OS X 10.5

1. Open a photo or document in an application.
2. Open the File menu and select Print.
3. Select your Epson Artisan 710 Series as the Printer setting.
4. Click ▼ to expand the Print window, if necessary.
5. Select the basic page setup options. For borderless photos, choose a Paper Size setting with a Borderless option.

Note:
If the setting you want isn’t shown (for example, Scale), check for it in your application before printing. Or check for it in the settings for your application at the bottom of this window. (If you’re printing from Preview, you see the settings shown below.)

6. Choose Print Settings from the pop-up menu, then select the following print settings:

7. Choose any other printing options you may need from the pop-up menu. See the online Epson Information Center for details.
8. Click Print.

9. To monitor your print job, click the icon in the dock. Select your print job, then select an option to cancel, pause, or resume printing, if necessary.

Mac OS X 10.3 and 10.4

1. Open a photo or document in an application.
2. Select Page Setup from the File menu. Select the following settings:

For borderless photos, choose a Borderless option in the Paper Size list for your paper size.
3. Click **OK** to close the Page Setup window.

4. Select **Print** from the File menu. You see a window like this one:

![Print window](image)

5. Choose **Print Settings** from the pop-up menu, and select the following print settings, as necessary:

![Print settings window](image)

**Note:**
In certain programs, you may need to select **Advanced** before you can select **Print Settings**. For more information about printer settings, click the ? button.

6. Click the **Advanced** button to change additional settings.

**Note:**
For more information on advanced settings click ?.

7. Choose any other printing options you may need from the pop-up menu. See the online *Epson Information Center* for details.
8. Click Print.

9. To monitor your print job, click the icon in the dock (or click the Print Center icon and double-click Artisan 710 Series on the next screen).

Selecting the Correct Paper Type

Select the correct Type (see page 27) or Media Type (see page 29 or 31) setting in your printer software. This tells the Artisan 710 Series what kind of paper you’re using, so the ink coverage can be adjusted accordingly.

<table>
<thead>
<tr>
<th>For this paper/media</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-gloss</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>Ultra Premium Photo Paper Luster</td>
</tr>
</tbody>
</table>
Two-sided Printing

The auto duplexer lets you print on both sides of the page automatically. You can use the auto duplexer with letter- or A4-size plain paper or Epson Bright White Paper.

**Note:**
If you remove the auto duplexer, you cannot print or copy.

**Windows**

Follow the Windows printing instructions beginning on page 26, but complete the additional steps below before you start printing.

1. Click the **Page Layout** tab in the printer software.
2. Select Auto as the 2-sided printing setting.

   **Note:**
   The Manual setting performs two-sided printing without the duplexer. When you use this setting, the printer software prompts you to reload the printed pages.

3. If you’re printing on plain paper and you notice that ink smears or bleeds through the page, click Adjust Print Density to reduce the print density and increase the ink drying time.

**Mac OS X**

Follow the Macintosh printing instructions beginning on page 28 (Mac OS X 10.5) or page 30 (Mac OS X 10.3 and 10.4), but complete the additional steps below before you start printing.

1. Select 2-sided Printing Settings from the pop-up menu.

2. Select 2-sided Printing.

   **Note:**
   If you see a message indicating that the auto duplexer is not installed, open EPSON Printer Utility3 (in the Applications folder on your hard drive), select Artisan 710 Series, click OK, click the Printer and Option Information button, and click OK again. Then close and reopen the print window.

3. If you’re printing on plain paper and you notice that ink smears or bleeds through the page, you may need to reduce the print density and increase the ink drying time.
Scanning a Document or Photo

You can use the included Epson Scan software to scan original documents and photos and save them as digital files on your computer. See “Basic Scanning” below.

You can also scan from your Artisan 710 Series control panel and send the images to a memory card or to your network- or USB-connected computer. For more information on these topics, see the online Epson Information Center.

The Epson Scan software provides four scanning modes:

- **Full Auto Mode** scans quickly and easily using automatic settings.
- **Home Mode** previews your image and provides preset options for scanning.
- **Office Mode** previews your image and scans text documents quickly.
- **Professional Mode** previews your image and provides a full array of tools.

**Basic Scanning**

You can scan from any TWAIN-compliant application using Epson Scan. Or you can start Epson Scan directly from your computer and save your image to a file.

1. Open the document cover and place your original face-down on the scanner glass, in the back left corner, as shown on page 12.
2. Close the cover gently so you don’t move the original.
3. Do one of the following to start Epson Scan:
   - **Windows**: Double-click the EPSON Scan icon on your desktop.
   - **Macintosh**: Double-click EPSON Scan in the Applications folder.
   - If you are scanning from an application, start your application. Then open the File menu, choose Import or Acquire, and select your Artisan 710 Series (if necessary).
4. If the Mode setting in the upper right corner is set to Full Auto Mode, click the Scan button.

**Note:**
If you want to automatically restore a color photo as you scan, click the Customize button, then check the Color Restoration box.

- If you are scanning from Epson Scan directly, the image is scanned and you see its icon in Windows Explorer or Macintosh Finder.
- If you are scanning from an application, the scanned image opens in your application window.
- If you are in Home, Office, or Professional mode, you see the Epson Scan settings window.

You see the Epson Scan standby window.
Maintaining Your All-in-One

Follow the steps here to check and clean the print head, and replace ink cartridges. To align the print head, if necessary, see the online Epson Information Center.

Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, the print head nozzles may be clogged. Follow these steps to check the print head nozzles:

1. Load letter- or A4-size plain paper in the main paper tray.
2. Press the Home button.
3. Press ◀ or ▶ to select Setup, then press OK.
4. Press ◀ or ▶ to select Maintenance, then press OK.
5. Select Nozzle Check, then press OK. You see this screen:
6. Press ◇ Start.
7. Check the nozzle check pattern that prints to see if there are gaps in the lines:

8. If there are no gaps, the print head is clean. Select Finish Nozzle Check, then press OK.
   If there are gaps or the pattern is faint, select Head Cleaning, then press OK. Then press ◇ Start to clean the print head.
Cleaning the Print Head

If print quality has declined and the nozzle check indicates clogged nozzles, you can clean the print head. Print head cleaning uses ink, so clean it only if necessary.

**Note:**
You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first (see page 41).

1. Load letter- or A4-size plain paper in the main paper tray.
2. Press the **Home** button.
3. Press ◀ or ▶ to select **Setup**, then press **OK**.
4. Press ◀ or ▶ to select **Maintenance**, then press **OK**.
5. Select **Head Cleaning**, then press **OK**.
6. Press ◀ **Start**.
   
   Cleaning takes about 2 minutes. When it's finished, you see a message on the display screen.

   **Caution:**
   Never turn off the printer during a cleaning cycle or you may damage it.

7. Select **Nozzle Check**. Then press ◀ **Start** to run a nozzle check and confirm that the print head is clean.
8. Select **Finish Cleaning** and press **OK** when you're done.

**Note:**
If you don't see any improvement after cleaning the print head four times, leave your Artisan 710 Series turned on and wait at least six hours to let any dried ink soften. Then try printing again. If you do not use your Artisan 710 Series often, it is a good idea to print a few pages at least once a month to maintain good print quality.
Checking the Ink Cartridge Status

Your Artisan 710 Series will let you know when an ink cartridge is low or expended by displaying a message on its screen or on your computer. You cannot print or copy when an ink cartridge is expended even if the other cartridges are not expended (but you can still scan and view photos on the display screen). Replace any expended cartridges before printing or copying.

To check ink cartridge status from the display screen anytime, follow these steps:

1. Press the Home button until Setup is selected. Then press OK.
2. Press ◀ or ▶ to select Ink Levels, then press OK. You see a screen like this:
   - A cartridge marked with ▲ is getting low on ink. See page 41 to replace the cartridge, if necessary.
3. Press OK to exit.

A window may appear on your computer screen when you try to print when ink is low. This window can optionally display ink offers and other updates from Epson.

Note:
To disable checking for ink offers or updates from Epson, see the instructions in your online Epson Information Center.
Purchasing Epson Ink Cartridges

You can purchase genuine Epson ink and paper at Epson Supplies CentralSM at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Use the following list when you order or purchase new ink cartridges (you can mix Standard- and High-capacity cartridges):

<table>
<thead>
<tr>
<th>Color</th>
<th>Standard Capacity</th>
<th>High Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>—</td>
<td>98</td>
</tr>
<tr>
<td>Cyan</td>
<td>99</td>
<td>98</td>
</tr>
<tr>
<td>Magenta</td>
<td>99</td>
<td>98</td>
</tr>
<tr>
<td>Yellow</td>
<td>99</td>
<td>98</td>
</tr>
<tr>
<td>Light Magenta</td>
<td>99</td>
<td>98</td>
</tr>
<tr>
<td>Light Cyan</td>
<td>99</td>
<td>98</td>
</tr>
</tbody>
</table>

**Note:**
We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a small amount of ink remains in the cartridge after the “replace cartridge” indicator comes on. The printer ships with full cartridges and part of the ink from the first cartridges is used for priming the printer.

For best printing results, use up a cartridge within six months of opening the package.

Store ink cartridges in a cool, dark place. If cartridges were exposed to cold temperatures, allow them to warm up to room temperature for at least 3 hours before using them.
Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin. You must install new cartridges immediately after removing the old ones.

**Caution:**
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability. Leave the expended cartridge(s) installed until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out. If you remove a low or expended cartridge, you cannot reinstall and use it.

1. Turn on the Artisan 710 Series.

   If a cartridge is low or expended, you see a message on the display screen. Note which cartridges need to be replaced and press OK. If you're replacing an expended ink cartridge, follow the instructions on the display screen. (You cannot print until you have replaced any expended ink cartridges.)

   If you're replacing a cartridge before it's expended, follow the steps below.

2. Open the scanner.
3. Squeeze the tab on the cartridge and lift it straight up. Dispose of it carefully. Do not take the used cartridge apart or try to refill it.

**Warning:**
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. Keep ink cartridges out of the reach of children.

4. Remove the cartridge from the package. Do not touch the green chip on the side.

5. Remove the yellow tape from the bottom of the cartridge.

**Caution:**
Do not remove any other labels or seals, or ink will leak.

6. Insert the new cartridge into the holder and push it down until it clicks into place.

7. Close the scanner.

**Note:**
If you see a warning message that the cartridge you just replaced is not installed, open the scanner and press down the cartridge securely.
Solving Problems

Check the messages on the display screen to diagnose the cause of most problems. Press the Home button, if necessary, then press ◄ or ► to select Problem Solver. Press OK, then press ▲ or ▼ to see all the help topics.

You can also check the basic troubleshooting suggestions starting on page 44 or see the online Epson Information Center for more detailed help.

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your Artisan 710 Series software. Open your online Epson Information Center and select Download the Latest Software or visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada).

With Windows, you can select Driver Update on the Maintenance tab in the printer settings window. You can also click or Start, select All Programs or Programs, select EPSON, select EPSON Artisan 710 Series, and click Driver Update.
Problems and Solutions

You can often solve problems by checking the messages on the display screen. If the information doesn't help you solve the problem, check the solutions below.

Note:
If the screen is dark, press any button to wake the printer from sleep mode.

Printing and Copying Problems

■ Make sure your paper is loaded printable side down (usually the whiter, brighter, or glossy side). Don’t load paper above the edge guides.

■ Make sure the type of paper you loaded matches the paper size and paper type settings on the control panel when copying or printing (see page 16), or in your printer software (see page 32).

■ Make sure your original is positioned against the back left corner of the scanner glass. If the edges are cropped, move your original away from the edges slightly.

■ If you’re copying, place the document flat against the scanner glass.

■ Clean the scanner glass with a soft, dry, lint-free cloth (paper towels are not recommended), or use a small amount of glass cleaner on a soft cloth, if necessary. Do not spray glass cleaner directly on the glass.

Paper Feeding Problems

If paper jams when printing, check the following:

1. Open the scanner and remove paper as shown, including any torn pieces.

   Caution:
   To prevent damage, avoid handling parts inside the printer.
2. Pull back on the tabs to remove the cover inside the Artisan 710 Series. Then remove the paper as shown, including any torn pieces.

3. Reattach the cover and close the scanner.

4. You may also need to check other locations for jammed paper, such as the auto duplexer, the paper cassette, and underneath the printer. See the online Epson Information Center for more information.

Print Quality Problems

- For the best print quality, use Epson papers (see page 10) and genuine Epson ink cartridges (see page 41).

- If you notice light or dark bands across your printouts or they are too faint, run a nozzle check (see page 37) to see if the print head needs cleaning.

- If you notice jagged vertical lines, you may need to align the print head. See the online Epson Information Center for instructions.

- The ink cartridges may be low on ink. Check your cartridge status (see page 39) and replace cartridges, if necessary (see page 41).
Where To Get Help

Epson Technical Support

Internet Support
Visit Epson’s support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

■ Product name (Artisan 710 Series)
■ Product serial number (located on the label in back and under the scanner)
■ Proof of purchase (such as a store receipt) and date of purchase
■ Computer configuration and description of the problem

Then call:

■ U.S.: (562) 276-4382, 6 AM – 6 PM, Pacific Time, Monday through Friday
■ Canada: (905) 709-3839, 6 AM – 6 PM, Pacific Time, Monday through Friday

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink, paper, and accessories at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Other Software Technical Support

ArcSoft Print Creations
www.arcsoft.com/support
Important Safety Instructions

Before using your all-in-one, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the product.
■ Use only the type of power source indicated on the product label.
■ Use only the power cord that comes with the product. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
■ Place the product near a wall outlet where the plug can be easily unplugged.
■ If you won’t be using the product for a long period, unplug the power cord from the electrical outlet.
■ Always turn off the product using the \( \text{On} \) button, and wait until the \( \text{On} \) light stops flashing before unplugging the printer or cutting off power to the electrical outlet.
■ Avoid plugging the product into an outlet on the same circuit as a photocopier or air conditioning system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
■ Do not let the power cord become damaged or frayed.
■ If you use an extension cord with the product, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Place the product on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
■ When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak from the cartridges.
■ Avoid placing the product in locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the product for sufficient ventilation. Make sure the product is at least 4 inches (10 cm) away from the wall.
■ Do not place the product near a radiator or heating vent or in direct sunlight.
■ Do not block or cover openings in the product case or insert objects through the slots.
■ Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
■ Do not press too hard on the document table when placing the originals.
■ Do not open the scanner section while the product is in use.
■ Do not touch the flat white cable inside the product.
■ Do not spill liquid on the product.
■ Adjust only those controls that are covered by the operating instructions. Except as specifically explained in your documentation, do not attempt to service the product yourself.
■ Unplug the product and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance.
■ WARNING: The cords included with this product contain chemicals, including lead, known to the State of California to cause birth defects or other reproductive harm. Wash hands after handling. (This notice is provided in accordance with Proposition 65 in Cal. Health & Safety Code § 25249.5 and following.)

**LCD Screen Safety**

■ Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
■ If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

**Ink Cartridge Safety Instructions**

■ Keep ink cartridges out of the reach of children and do not drink the ink.
■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water. If you still have discomfort or vision problems, see a doctor immediately.
■ Do not put your hand inside the product or touch any cartridges during printing.
■ Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the product from printing.
If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the product. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area. Do not store the cartridge upside down.

Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for the warranty period, as measured from the date of original purchase. The “warranty period” means two years, if you registered your printer purchase with Epson within 60 days of purchase, and one year otherwise. For residents of California or Quebec, failure to submit the product registration form does not diminish your warranty rights. For warranty service, you must provide proof of the date of original purchase.

This limited warranty statement also covers any Epson-branded duplexer purchased separately for use with the printer. The warranty period for your duplexer is the same as the period for your printer. In this limited warranty statement, the “product” means the printer and the duplexer.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson Connection℠ at (562) 276-4382 (U.S.) or (905) 709-3839 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If Epson authorizes repair instead of exchange, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be repaired and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.
What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high-duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF THE ORIGINAL RETAIL PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: http://www.epson.com.
To find the Epson Customer Care Center nearest you, visit http://www.epson.com/support.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012

---

**Declaration of Conformity**

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Multifunction printer
Model: C391A
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson is a registered trademark, Epson Exceed Your Vision is a registered logomark, and Supplies Central is a service mark of Seiko Epson Corporation.

Artisan is a registered trademark and Epson Connection is a service mark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.

© 2009 Epson America, Inc. 5/09